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Main Aims of this Course.

1. to introduce the basic theory of GIS, the idea of data models and representation of
geographical data, projections, scales, georeferencing.

2. to understand how different types of data can be integrated into GIS
3. to gain confidence in using Arcview and TANGIS.
4. to explore possible modelling tools.



LTBP TANGIS TRAINING GIS THEORY AND APPLICATION

3

PART ONE - CONCEPT OF GIS

Aims

In this section:
We give you an overview of the main concepts of GIS including:

• Data models (vector and raster)
• Data formats used in TANGIS
• Scale
• Projection.

We give you a few examples how the data can be used, including:
• Data organisation
• Visualisation
• Inquiry and selection
• Modelling and prediction.

Notes

What is a GIS?
A GIS consists of:
• Hardware
• Software
• Peripherals
• Data
• Information
• Spatial Referencing
• People

GIS is defined as
" A computer system capable of holding and using data to describe places on the
earth's surface"

Or:
"An organised collection of computer hardware, software, geographic data, and
personnel designed to efficiently capture, store, update, manipulate, analyse and
display all forms of geographically referenced information."

I prefer:
"An environment in which you can solve your spatial problems."
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With a GIS you can
Input data
Manage data
Manipulate data
Analyse data
Model data
Output data

Modelling the earth's surface
The data stored in the GIS are an abstraction of the real world.  We have to simplify
the earth's surface.  There are two methods for this:

1. Vector model
Where features are defined on the earth's surface. They can be simplified into three
main groups or feature types;
• Points - for a feature with one dimension (e.g. a spot height, a survey point).
• Lines - linear features such as rivers, roads, coastlines, transects.
• Areas or polygons - these are features which cover some ground such as a forest,

national park, administrative boundary or a lake.

Note that the scale of the map that you are working with determines the features that
you are looking at.  For instance, an airstrip might appear as a point on a 1:1 Million
map, could be a line on a 1: 100 000 map but is a distinct area on a 1: 25 000 map.

The vector model comes from cartographic tradition and is useful for compact data
storage, querying of data and visualisation, particularly of discrete man-made
datasets, but is problematic for showing natural continuous data or for modelling.  It
also allows a large number of attributes (data) to be attached to each feature.  Thus for
a survey point, you could have other information on water depth, number of fish
species, substrate, as well as the positional data.

2. Raster Model
This divides up the surface of the earth into cells or pixels of equal dimension and
assigns thematic values to each position.  Generally only one attribute can be assigned
to each pixel.

The raster model comes from a remote sensing tradition and is useful for display of
satellite imagery or continuous data (such as elevation or vegetation types).  It is very
useful in modelling data but is data intensive and difficult to handle visually or for
query.

Types of raster and vector data
The GIS system used in the LTBP allows for data of both raster and vector types to be
shown together.
In ArcView there are two types of vector data:
Coverage - a vector format that allows more than one feature type for a dataset (e.g.
administration layer contains both the areas of the administration zone and the
boundaries)
Shapefile - these are the main format of vector file for Arcview but only allows one
feature type.



LTBP TANGIS TRAINING GIS THEORY AND APPLICATION

5

There are two forms of raster dataset:
Image Files - these are basic image file formats that allow visualisation of raster data.
These include the following formats: TIFF, BMP, LAN and IMG (ERDAS Imagine
Image processing data),
GRID data - these are a special form of raster data from ARCVIEW which allows
you to manipulate the vales held.

There are tools available in Arcview that allow you to switch from one to another
format.

Other sources
As well as these GIS data formats, the TANGIS system allows you to integrate data
from other sources:
Geo-referenced text data  - These are tabular form data which have two columns
containing X and Y data (e.g. latitude and longitude).  These can be in various tabular
formats, such as DBASE IV, comma separated or space separated text data (e.g. from
an Excel Spreadsheet), or directly from a database such as Access (e.g. the BIOSS
survey database).  The treatment of the Access data is different from the other forms
of text data, so it is catalogued separately in the metadatabase.

Non geo- referenced text data - If a table of data has no x,y, co-ordinate data, but
instead has some reference to a place ( a name of a village or district, bay or river),
then as long as that geographical dataset exists (called a FRAMEWORK dataset), you
can join the dataset into the GIS (see User Manual p. 18 Showing Text (Non-Georef)
Data).

Scale

Depending on the application of your work, you need data to have a certain amount of
detail in it.  Work on the whole catchment area will need different data from working
in one small bay.  The Scale of your data is an important concept, as it helps to define
the level of detail in your data.

In maps, large scale means a lot of detail.  Therefore a 1: 25 000 map of a bay is able
to show rocky outcrops.

Some rules of scale:
• The larger the scale, more detail exists
• The larger the scale, the better positional precision exists.
• The smaller the scale , the more area you can cover
• The larger the scale, the larger the dataset has to be to cover the same area
• You should not combine data of incompatible scales (e.g. do not overlay a

watershed map at 1: 1 Million with a river map at 1: 50 000.
Already mentioned is that the way a GIS represents data as different feature types at
different scales ( for example the airstrip)

In TANGIS and the metadatabase, which we shall look at later, the quoted scale is
that of the original dataset.  Data are given a highest and lowest scale that they can be
represented on the view.
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Projection
The earth's surface is a slightly flattened globe, but the representation of the earth's
surface on a map or a computer screen means that it has to be "projected" to a flat
surface.  There are many different ways to do this, and advantages or disadvantages in
using different map projections.

The LTBP GIS uses two projections.
Platte Carre - or a flat geographic projection where lines of latitude and longitude are
equal distances apart. Useful for positional information and flexible to go to other
areas.
Universal Transverse Mercator  (UTM) - this is a standard projection for many maps
and is measured in meters from a false origin.  This is the South Pole in the region,
and the Northings measure the number of metres from the South Pole

In the region, Tanzania uses two map UTM projections - Zone 35 and Zone 36,
Zambia uses Zone 35 an Burundi uses a Transverse Mercator Projection which is
equivalent to Zone 35.5.  Since most of the lake falls in this zone, Zone 35 has been
chosen as the main UTM projection for the project

Features, advantages and disadvantages of each projection

Features Platte Carre (Geographic) UTM Zone 35
Units system used Latitude Longitude Metres based
Spheroid Sphere Clarke 1886
Locational Good for overall location,

often default used in GPS
Good in reference to
country maps

Measurement Poor Good , produces distance
and areal measurements
easily

Comprehension Easy to understand
derivation.

Difficult to understand
derivation and use.

Conversion from one projection to another
There are now some facilities within Arcview to transfer from one projection to
another.
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How can I use GIS in my work
GIS can be used as a tool in assisting your work.  It has several applications:
1. Organising data - all the special studies have geographical data of one sort or

another.  You can organise your datasets geographically, which allows them to be
integrated with other data from elsewhere in the project.  For example, because of
their shared geographical location, data on pollution amounts in a river can be
correlated to the biodiversity survey data.

2. Visualising data - you can show your data as a simple location map, or you could
symbolise your data to show a contrast between different results in your attribute
table (e.g. number of fishing boats around the lake).  These can easily be
composed using TANGIS and output as a bitmap file or a print out for a report.

3. Querying data - you can use the TANGIS system to query your data.  You can
use it to ask specific questions:
• What is where - for example to point to a location on a map and find out what

the population is there.
• Where is what - query your table and use the GIS to show all locations that

satisfy that query (e.g. you could ask to show where Afromast spp. are located)
• What is within a distance of?
• What is the size of?

4. Modelling you data - to predict changes or to interpolate your data across an
area.

Exercises

Data types
Can you suggest which data types these data would be best suited to?

• Forest
• Pollution monitoring sites
• Vegetation status
• River
• City
• Population statistics

Scale
1. Open TANGIS and Switch to a General View.  Add the background layers and

now add a theme called coast50.
2. Note down 4 ways the lake dataset and the coast50 differs

Projection
Look at the datasets for Land cover in the region and the Digital Elevation Model.
Why do they not match in the same view?

Usage of GIS
Can you give a few examples of how GIS may be of use to you?  Give a specific
example from your current LTBP work.
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PART TWO - INTRODUCTION TO TANGIS
AND THE LTBP DATASETS

Aims
In this section you will learn how to:
• Open TANGIS
• Look at the datasets of LTBP
• Get an overview of the datasets in the LTBP GIS database
• Learn how to get hold of data and how TANGIS links with other GIS in the

region.

Notes

Opening TANGIS

What Is TANGIS?
TANGIS is an interface.  It is a program that allows you to look at the data held in the
database.  It has some functions that allow you to investigate the data in the system.

How to open TANGIS
TANGIS should have been installed as an icon on your desktop.  If not, you have to
open it from Arcview.
Use File Open and select the tangis\laketan31sa.apr or Laketan3.0sa.apr depending
on which version of Arcview you are working with.
TANGIS automatically opens and you are shown the overview showing where the
Special Studies are located.

To move around all the interfaces in TANGIS
Each special study has its own interface, and there are also two extra interfaces; the
planning and the general interface

• In the general interface you can add all data.
• In the planning interface you can add data according to the area it covers.

To move around the different interfaces, use the Switch to menu

To add data to a view
To add data to a view, click on the Add data menu and select one of the categories:
If you want to add data specific to the interface, click on the name of the interface
(e.g. SEDIMENTS)
If you want to add from any of the datasets, click on ALL DATA
If you want data only of one type, select it (e.g., select Images, Other Raster, Map
data (vector), Text data.

To remove data from a view
Select the Remove data from the menu

• If you want to remove all data select All data
• If you want to remove data of a certain type, click on type of data.
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Types of dataset in the LTBP dataset

There are various sorts of data in the database, and they can be classified different
ways:
By type (e.g. raster, vector)
By application (e.g. Pollution study, Fishing Practices)
By source (satellite data, map data, Special study database, survey)

All these datasets can be stored in the Metadatabase and the digital datasets can be
shown through TANGIS.
Web site – you can search for data through the web site.  If you have TANGIS,
though, you can directly search for the right datasets by using the Add data menus.

Some of the important datasets in TANGIS:
• Background maps – 1:1 Million scale maps of the main topographical features:

roads, rivers, lakes, railways, settlements
• Extra land data – National parks and reserved land, land cover
• Elevation data – 1km raster data for the whole of the region, metre accuracy; slope

map.
• Logistical data for project – study areas, project offices, GIS contacts database,

sites of all special study activities, pollution, sedimentation survey sites.
• Bathymetrical data – bathymetry map of whole lake, index of individual sheets at

higher scale, map of three basins
• Survey databases – BIOSS survey database, Pollution database (soon?), Core

samples from ships’ surveys.
• Geographical information – gazetteer of lakeshore, settlement names.
• Socio-economic/administrative data – districts and other administrative units,

population statistics, boat surveys.

How do I get more data?

1. Check your copy of TANGIS
2. Search through the LTBP data catalogues on the web site
3. Use the web page to find more sources
4. Link in with the Environmental Information Centres in each country –

• Burundi – MINATE
• DR Congo?
• Tanzania – NEMC/ TANRIC
• Zambia - ECZ

4. Gather it yourself – use the guidelines in the fourth part of this training
manual.

Check
When you get a new dataset source, check the source of the data – who originally
made it and for what purpose
Check the format – will it fit into your GIS – is it a shapefile, image or database?
The scale – is it suitable for the work you are doing?
The time it was made – is it up to date?
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Exercise

1. Open up TANGIS and add datasets of different types into your view
2. Familiarise yourself with being able to add or remove data, and show.  Learn how

to move datasets to the front of a display.
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PART THREE - INTRODUCTION TO
ARCVIEW

Aims
In this section you will learn how to :
• Open up Arcview
• Understand projects and documents
• Add data to a view
• Document a view
• Navigate around the view and zoom in and out

Notes

Although TANGIS is part of Arcview, the extra TANGIS menus we have been using
are a lot easier to use than the Arcview menus.  However, for the rest of this course,
we shall concentrate on the fuller functionality of the whole of Arcview, so we’ll
learn more detail of its programs and menus.

Opening Arcview
To start Arcview, you click on the Arcview icon in Program Manager.

Introduction to a "Project"
Arcview is a program allowing you to manage your geographical documents.  The
documents are stored in a project.  There are several different types of documents in
an Arcview project.  You can consider the project as a filing cabinet and each
document is stored in a different drawer, according to its type.

The types of documents you will use in Arcview are:
A View - an interactive map showing your data
A Table - shows tabular representations of your data
A Chart - shows graphical representations of data
A Layout - allows you to put together tables, charts and views so that you can print
out or present your data.

Each of these documents have elements or objects associated with them:
e.g. a View is made up of different geographical layers, called Themes.
The project, the documents and the objects all have a set of attributes associated with
them called properties.
• A Project has properties (name, selection colour)
• A View has properties (Map units, name, comments)
• A Theme has properties (description, name, label field).

Making a project.
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When you open up Arcview, you are shown a project window.  To look at the list of
documents of a particular type, click once on its icon in the left hand side of the
project window.

e.g. Click on the table icon
A list of tables would appear here.
At the moment the filing cabinet is empty.

How to save a project
Click on the Save button.
Write a name for your project.  Click on OK.

The name of the project now appears in the top of the window.

Help
You can get help in three ways:
1. Menu - Help Contents

2. Help using the  button (Contextual help) and highlight a menu or button
in the Arcview window.

3. Help Search for a key term.

Views

Making a view
For GIS users, the major function of a GIS is to show your data in map form. In
Arcview this is done through using View documents.  To make a view:
Highlight the View icon in the project window.

Click on the New button.

Elements of a View
A View has :
• a Menu - these list all the functions you can do with a view or elements of a view
• a Table of contents (TOC) - this is the grey area on the left which contains a

list of all you data and how it is represented.
• a Display - this is the white area in the centre that contains all your data.

View Properties
You can set view properties by clicking on the View menu and selecting
Properties option.  This allows you to :
• rename the view
• Add comments to the view
• Set the map units and the distance units

E.g. , your map may be referenced in metres and you may want to measure
distances in Kilometres.

Note when you change this, you see the current scale of your map in the scale
window.

Adding data to a view - Themes
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Views are made up of Themes or layers of geographical information.  Themes can
be from many different data sources:
• Arc INFO Coverages.
• ArcView Shape Files.
• Satellite images.
• Point data saved in a table (e.g. GPS points).
• ARCINFO raster GRID data.
To display a theme, you need to click on the Add theme button:

To add an Arcinfo coverage:
Make sure that Data type is set to Feature Data Source.
Now click on the directory where your data are stored and select the
data set you wish to add.

To add more than one theme at a time, use the mouse button with the Shift button.
Click on OK.

The data are shown in the table of contents.

You can make a theme visible and active.
To make a theme visible (i.e. so you can see it in the display)
Click on the little check box.

To make it invisible, turn the check box off.

An Active theme is one highlighted in the table of contents.  You can make a
theme active by highlighting it in the table of contents (TOC).  Click anywhere in the
area of the theme in the TOC.  When you make a theme active, it allows you to :
• Zoom to the extent of this theme
• Look at the associated attribute table for the active theme
• Look at the active theme’s properties
You will notice that many of the buttons and menu items in the view become enabled
when you have an active theme.  Again, you can make more than one theme active at
a time using the shift button.

Theme Properties
You can set a theme's properties by making the theme active and selecting Properties
from the Theme menu.  A dialogue box appears.
You can change all the theme’s properties in here.
• Name
• Definition
• Text label position
• Scale of view thresholds
The main property you will be interested in is the name of the theme.
By default the file name from the source data is used when you add a theme to a view,
but you can call this anything you like - and you should endeavour to make the theme
name more meaningful for any users.

To change the theme name, click on the name field and type the new name in. When
you press OK, the TOC is updated with the new name.  Note: this does NOT change
the file name of the data, it only changes the reference to the theme in this view.
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Note you can open up the same data source in more than one view, or twice or more
in the same view; it can then be used to show different expressions of the same
dataset.

Zooming and Navigating around the view
There are many ways you can zoom in to different parts of your display.

1. Zoom in button:  Zooms in by two

2. Zoom out button:  Zoom out by two

3. Zoom in tool : Click and drag
4. Zoom to active theme - if you have made a theme active in the table of

contents, you can zoom to the selected one: 

5. Zoom to extent of all themes: 

6. Zoom to selected features of active theme: 
7. Pan - using the hand tool, you can grab a part of the image and move it around

the view.
8. Type a new scale in the scale box.  The view resizes to that scale around the

centre point of your current display.

Exercises

1. Start Arcview and save the project
2. Make a new view.  Set the properties to decimal degrees units, and kilometres

distance units.
3. Add the following themes; lake, road, river.
4. Experiment with the Zoom in and zoom out tools.  Look at the scale bar.  How

does this change?
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PART FOUR - DATA INPUT

One of the most important parts of GIS is entering data into the system.  Here we give
you a few tips on creating data.

Aims

In this section you will learn:
• Tips on creating databases
• Some fundamentals about digitising.
• Incorporate tabular data into maps

Notes

Creating a database
Creating a structured database that can be used in GIS is very  important.  The
database needs only a few features, so here are a few general rules:
2. Two columns with the X and Y geographical co-ordinates
3. Separate columns for each "Attribute" of data.
4. The columns should contain only data of one particular type (e.g. numerical,

character, date or Boolean).  This makes the dataset far more versatile when you
want to analyse it.

5. Unique and sensible names for each column heading
6. We recommend that each feature has a unique identifier, so that you can

distinguish it easily on your map.
7. Put one piece of information in each column (i.e. do not put latitude and

longitude, or time and date, in the same column; separate them).
8. Never put the units of data in the data fields themselves, only in the column

headings.
9. If you are trying to classify the data, try and standardise the classes used (e.g. do

not have two classes called "sand and gravel" and "sand/gravel").
10. Check for all spelling mistakes carefully.
11. Make sure you have a way of distinguishing between Zero and NO data values.
12. Don't use "" to repeat data - always put the full description.
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Ways to present the data
Presenting Locational Information
Any latitude-longitude data must be in decimal degrees, not in degree, minute,
second.
5 °15’30"=5.255 (be careful to put " . "and not " , ", as Arcview does not recognise
the French punctuation )
The references to the hemisphere must be with a negative sign, not with N or S
references or E, W. Only numbers are allowed in these columns
5° S = -5
3o W = -3

Units
The units of the numeric data must be in the header of the column, not in the column
itself and no blank cells are allowed in the header of the columns.

Format
Try to have only one row containing headers information, and at the top of the
spreadsheet only. Delete all empty rows.
It is useful to have a unique ID number for each row.

Data
Only put numeric data in numeric columns.

Time
Time is an important part of datasets, particularly in relation to the Strategic Action
Programme of LTBP.  Think carefully when designing you databases how you will
incorporate time  - e.g. have separate columns for different timed measurements, or
have a single column to record the data of every observation.  Which one is more
useful for your application?
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Digitising

If you need a lot of digitising conducting, you should get in  touch with one of the
many institutes around the region who can supply digitised maps.  Be careful to give a
good description of what you want:
Define:
• The scale of the digitising
• The map projection details
• The exact area you want to cover
• The attribute information you want, and how you want it coding.
• The output format

If the digitising is simpler, you may like to have a go yourself "on screen".

In Arcview, you can create new shapefiles.
• In the View menu , select New Theme
• Choose the type of data you want to digitise (point, line or polygon)
• Choose a filename and location
• Make sure the correct graphic tool is showing; point, line or polygon
• Draw your shapes;

• If you are drawing points, each click will draw a feature
• If you are drawing lines, click once for each vertex and do a double click to

end a line.
• If you are drawing polygons, click once for every vertex, and do a double

click to close that polygon
There are various other tools to help you draw features.
On-screen digitising is quite difficult to master to start with.  Start slowly and build

confidence.

Exercise

1. Load the table Sample.csv into an Excel spreadsheet.  Name fifteen things that are
wrong with the data.

2. Make a view that contains the background map data.  Now imagine that you are
running a survey along the lake shore, create survey points using the New Theme
menu in Arcview.  Call the theme Survey.shp.
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PART FIVE - LEARNING TO USE TABLES -
TABLES IN ARCVIEW

You can add tables to your ArcView project in several different ways:
1. from attribute tables of themes already shown in views
2. by adding other tables (.dbf or .txt)
3. by adding data from other databases (e.g. SQL databases).
Once you have added a table to a view, almost all tables are treated in the same way.

All tables are stored in the table folder in the project.
You can open a table by highlighting it in the project window and clicking on open.

The features of a table are:
• The Fields - these are the columns of data and their names are shown in grey

boxes across the top of the table
• The Records: these are the rows of data and each row represents the data stored

for one item (e.g. one feature in the associated theme)
• The table name - you can change the name of this in the Table Properties
• The number of records - this is shown in the second box on the top line
• The selection - you can select one or more records.  The number of records you

have selected is shown in the first box in the top line.
• An Active field is one whose name is highlighted  - you can do more operations

on a highlighted field which are not normally available.
 
Notice that the table menu is different from the View menu.  This is because there are
specific programs which are available for tabular operations.  We shall explore these
in a moment.

With a table, you can:
• Select data either using specific record selection or by building queries.
• Reorder your data or promote your selected data to the top of the table.
• Find specific data.
• Create new fields and enter new data.
• Calculate values based on operators and data values.
• Export the table elsewhere.

Connection between tables and themes

Most themes will have an associated attribute table - data about that theme, one
record per feature shown.  The data held in the attribute table is directly linked with
its geographic representation in the view.  That means that if you do operations on the
theme in the view, this is represented in the table.  And the opposite is also true.

This next section shows you how to select data in both the view and the table.

To select an item in a theme
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1. Make the theme active

2. Select the :  tool.
3. Now click on one of your features (note that it is a point feature, you have to get

the exact centre of the symbol).
You can multiple select by clicking a dragging in the view with this tool active.

Because most features have a range of attributes associated with it, you can do far
more sophisticated selection of data by using the Query Builder:

1. Select one theme to make it active.

2. Click on the   button in the menu.
3. A dialogue appears. you have to create a logical expression to select your data.
 This can take several formats
4. If you have a classification field, you can create a simple expression:
 ([soil_type] = “Loam”)

 For a numeric field, you have more options; such as setting thresholds
 [ph] =  5.5
 [ph] > 7

 or some calculations
 ([soil_depth] + 10) > 25

 or even combine data from different fields in your attribute table:
 ([soil_depth] > 20) AND ([ph]  = 7)
 ([soil_depth] < 10) OR ([ph] = 5.5)

 In each of the above cases, the procedure is the same.
5. Start by selecting the field you want to query by (from the left hand window) and

double click on it.
6. Then select the operator you want from the central set of buttons (e.g. +-*/)
7. Then select a value from the right hand window or type a value in to the space.
 Notice how the bottom window builds the query as you select.
8. If you want to make a query more complicated, surround key terms in brackets

and use the AND or OR buttons.
9. Once you have finished your query, click on the NEW SET button.
10. A new query will be run and the results are shown in the selection colour in the

theme.
 
You can do exactly the same in the table.
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Joining data in tables
If you have non-georeferenced data (i.e. with no x,y co-ordinates) , you can join them
into a theme using a common field (e.g. an ID number , name of village or district).

To do this.
1. Open up both tables
2. Select your source table (where you want to join data FROM)
3. Click on the field that is common to both tables
4. Select you destination table (where you want to join data TO)
5. Click on the Field common to both table

6. Select the Join button  (which should now be active)

The data should join together into the destination table.  You can then use this in your
view as with any other attribute data.
Note – the fields in both tables need to be of the same type, either both numerical or
both string.

Calculate

You can use the calculate button to calculate new values.  Look carefully at the
dialogue box that appears.  Note that this can only be used when the table is set to
editable.
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Exercises

Making and adding tables
1. Add a table document to your window called Sites.dbf
2. Add your Surveys theme to a view, select the attribute table and then add two new

fields called:
• ID – numerical type, 2 spaces wide, no decimal places
• “Water depth”, of numerical type and 6 characters across with 2 decimal

places.
3. Populate your table with this.

ID Water Depth
1 25.6
2 25.2
3 21
4 3.23
5 59.3
6 45.3
7 14.8
8 12.9

3. Save the table.

Querying data of tables
4. Add the Population of Congo dataset into the view.
5. Run a query that shows which districts had more than 500 000 in 1984.
6. Now run a query that shows those districts where the estimated population rise in

Congo was greater than 300 000
7. Now create new field in your table and calculate the population difference

between 1984 and the estimated population in 1995.
8. Can you show this data in the view using the Graduates Color legend type.

Joining Tables

1. Select the population of Zambia dataset
2. Add a table called zampop94.dbf to Arcview
3. Join the two tables together on the ID fields.
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PART SIX SYMBOLIZING YOUR DATA:

Presentation of your data in the most easily understandable form is one of the primary
aims of using Arcview.  Arcview gives you many ways of presenting your data.
We shall look at the Legend Editor here.
To open the legend editor, you need to make your theme active and then either double

click on the theme in the TOC or select the  button.

You can represent your theme as:
• a single symbol - e.g. a road
• a unique classified symbol - based upon the categories of your dataset:
 e.g. roads classified by road type (gravel, tarred, dual carriageway, single track)
• a graduated classified symbol (based on categories splitting your data into

a few classes)
 e.g. Population of villages in 5 classes; those between 0-1000, 1001-2000, 2001-3000

etc.
• charted - e.g. the proportion of people working in agricultural, industry and

services, with the population total as the symbol size.
Symbols are presented for all types of features; lines, points, annotation and
polygons.  You alter what symbol is used and how the symbol appears in the Palette
manager - choose Show Symbol Window from Windows menu.

You can vary the:
• point symbol (type, size, orientation)
• line symbol (width, pattern)
• text symbol (font, size, type)
• colour (of foreground, background,  text or outline)
• pattern

To change the symbol for each class:
1. Double click on the symbol
 A palette appears:
2. Choose the correct palette manager to edit your symbol:
3. Choose a symbol
4. Choose a colour
Notice how your choices in the palette manager are automatically updating the legend
symbol you have chosen.

You can also save and load legends.
Save using the Save button in the legend, saves the current legend as an AVL file
which you can reload at any time.  It is attached by default to the current dataset and
the field in that dataset, but can be applied to similar datasets.

Other ways of manipulating the look of a legend:
• Labelling - If your original data was coded, then you do not need to recode the

attribute table, but can just attach a label to a legend in Arcview
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• Click on the Label to update and type in a new value.
• Using ready-made palettes -Arcview has some created palettes listed in the

colour ramps option at the bottom of the legend.
• If you don’t like the legend, click on the Undo button and start again.

In Classify – you can find a whole different number of ways to represent your data:
You can have different numbers of classes.
You can classify: By equal area
• By Natural Breaks
• By Equal Interval
• Quantile
• Standard Deviation

Once you have finished updating all fields, click on the Apply button in the legend
editor to commit all the changes to the legend to the view itself.  Notice how the
changes are shown in both the TOC and in the representation of the dataset in the
display.

Click on Close to close the legend editor and return to the view.

Exercises

1. Load the sample.shp file into the view
2. Show the legend with Unique values for the substrate field
3. Experiment with the colours and symbols in the palette window
4. Show the survey.shp file you created in the last exercise.  Classify it with

Graduated Symbols classification.
5. Load the Population of Congo theme – Experiment with the different types of

classification types and the numbers of classes – how differently can you show the
data.
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PART SEVEN OUTPUT A MAP - CREATING
A LAYOUT

Aims

In this section, we shall learn how to make a pleasing map for the back of a report, or
to be published on the Internet site.

Notes

A layout is used to create a page that allows you to print out parts of your project.

You can add tables, charts, images and view to a layout but we shall concentrate here
on outputting a view. You can make a layout from a view if you have the view open.
First:
Make sure your view has all the elements it needs inside it:
• A group of themes all properly labelled and symbolised
• A series of legends for each theme
• The view is zoomed to the correct location
Now go to the View menu and click on Layout.
You are asked which template to use, choose landscape or portrait.
Now the layout appears with a series of graphic objects:
• the view inside a view frame ,
• the table of contents shown as a map legend,
• a scale bar, and a north arrow,
• a title.

You can rearrange any of these features by clicking on the graphic with the select tool

( ).  Small black boxes appear around the object to show it is selected.
• You can move the object now by clicking and dragging inside the box.
• You can resize by going to one of these black boxes and clicking and dragging the

box to a new size.

To add a new graphic to a layout, you can select from the drop down tool
menu:
For example:

 - add a new view frame

 - add a new chart

 - add a new table

 - add some text (e.g. a title)

 - add a scale bar
To edit what is in the view frame, you need to adjust the view:
• Change the view zoom to fit the area you want to display in the layout
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• Click items in the TOC on or off to decide what is shown in the layout.
• If you want a data layer to appear in the view frame but not in the map legend,

you can make the theme active, click on Theme menu and select Hide/Show
Legend.

 
You can change the properties of the layout or any of the Graphic elements in a
layout.
View Frame  properties include:
Scaling the view frame:
You have several options here;
• preserve the view scale, create a new scale, fit to the view frame.
You can also edit the relationship between the view and the view frame:
• fit to frame, same as View.
Once you are satisfied with the layout, you can click off the live link between the
view and the view frame.  This means you can continue to use the view (even create a
new layout in a different area with different components).

Layout Properties
There are several properties you can set here:
• You can rename the layout - this is how it appears in the project window, not

the title as it is printed out.  You have to edit text in the title if you wish to change
this.

• Moving the graphical elements around is normally controlled by the grid - which
helps in aligning features.  You can change the resolution of the grid in the
layout properties, or alternatively, click off the snap to grid option.

Printing out a layout
When you are satisfied with your layout, you can print it out.
1. Go to File Print Setup
 It is worth checking that the printer is set up correctly.
2. Check the landscape/portrait settings, the paper size and the

colour/quality settings
3. Click OK
4. Click on File Print
5. Click on OK
The system will take a few moments to start printing.

Saving the file as an image
1. Go to File and select Export
2. Select the file type
3. Locate where you want to place the file
4. Give the file a name
5. Press OK
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PART EIGHT - Using Raster data

Aims
In this section you will learn:
• About Spatial Analyst Extension in Arcview
• How Images and raster datasets are formed a what you can do with them
• Querying Spatial Analyst data.

Notes

Raster data needs different handling from vector or database information.  Arcview
deals with this using the Spatial Analyst Extensions and GRID datasets.

Starting Spatial Analyst
To Load Spatial Analyst:
• Go to the File menu in Arcview project window and select Extensions
• Scroll down to Spatial Analyst and click on the check box.

A new set of menus appear, and more functions to convert to GRID data.
You can analyse data:
• Distance measurements
• Proximity definition
• Summarize data
• Interpolate between points
• Make slope and aspect maps
• Query your data (e.g. to find the overlap between two themes)
• Reclass your data
• Calculate sophisticated relationships between data layers (e.g. in a soil loss

equation)

Analysis Properties
You can control how the raster data is processed through the Analysis Properties
window.

Here you can;
• Set up the co-ordinates of where the processing is going to occur
• Set up the cell resolution (the pixel size)
• Set up a mask (e.g. a country grid) which will only allow processing in that area

More about Raster data
Raster data can come from satellite imagery.  Satellite data can be used to map the
land, monitor changing status (e.g. of temperature or vegetation greenness), or to
monitor the weather.

Many other datasets suit being in Raster format.  They tend to be continuous data:
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e.g. Digital Elevation Model - this contains height information for every 1km pixel in
the region, with metre accuracy.

There are certain restrictions on raster data within the GIS.
1 - you cannot change projection from one grid to another.
2 - you cannot use the usual selection tools, but there are special programs to deal
with this

Exercise

1. Load the spatial analyst extension
2. Take the digital elevation model and calculate the slope and aspect
3. Zoom in on Kigoma.
4. Use the Kigoma grid which shows land cover.  Wood is classified as "Wo".
5. Look for where wooded slopes > 5 degrees
6. Add in the settlement dataset and select Kigoma
7. Find all the wooded slopes > 5 degrees within 50 km of Kigoma.
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PART NINE - USING THE DATA (1) –
VISUALISING RESULTS

Aims

In this section you will learn how to put the TANGIS interface to work to:
• Symbolise some maps and produce a pleasing output
• Run some simple queries on data.
• Pose some questions on your special study
• Show how to integrate data into potential strategic action plan activities.

Notes

One of the key parts of GIS is the ability to display your data in a meaningful way.
There is an English expression that a picture paints a thousand words.  If that is so,
maps can show two thousand words.
You need to think carefully how you will show your data.
Using all you have learnt up to now, you should be able to think of some data you
want to represent in a map.
Exercise

Make a view of some data, symbolise it and label it.  Then make a layout and export
the data.  Insert it in a Word report.
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PART TEN – USING THE DATA (2)
ANSWERING A PROBLEM -

The modelling process in GIS
There are five basic steps to modelling:

1. Defining the problem
2. Breaking down the problem into manageable parts
3. Defining values of suitability
4. Dataset collection and algorithm construction
5. Running the model

1. Defining the problem
Example:  Where have concentrations of pollution been affecting
biodiversity in Kigoma.

Often the first step is to rephrase the problem in more specific terms:
What is the proximity of concentrations of pollution to areas of rich
biodiversity

Then we need to define each of our terms:
Concentrations of pollution - more than 30 parts per million
Richness of biodiversity = more than 35 key species for Kigoma area -
What is meant by "Kigoma area".

2. Breaking down the problem into manageable parts:
It is often difficult to cope with a whole problem in one go.  So we need to break the
problem down:
Evaluate the pollution
Evaluate areas of rich biodiversity
Find which areas of pollution are close to the biodiversity

3. Defining values of suitability
You have to decide what values you have as factors or constraints to your model.

A Constraint limits the area where phenomena can take place
A Factor is where a set of ranking values is given to the dataset to evaluate
suitability;
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4. Dataset collection and algorithm construction
Now you have defined your datasets and the rankings, you have to gather the data
together and put each layer into a suitable form.
This could include:
• Calculations,
• Reclassifications
• Neighbourhood analysis.
• Statistic derivation

5. Running the model
Then you have to apply each of the data layers in the model you have created to get
the final result.  Again, the suite of spatial analyst options can allow you to do this:
e.g.
• Overlay
• Mathematical operations
• Zonal analysis

Extra points to consider
Surrogate Data
The expense of data collection sometimes stops you from defining perfect parameters
for your modeller, and it is often simpler just to rely on definitions from existing
datasets:
E.g. Good agricultural land might include:
• Highest crop returns
• flat land
• Deep soil
Which may take a lot of gathering and refining.  It is probably simpler to define this
part of your model as Grade 3 agricultural land from an existing map, or just using
one of these criteria to reclassify with.

When making a model you have to weigh up the advantage of well defined accurate
parameters with the cost and complexity of inputting that parameter.  Sometimes
surrogate measures are useful.

Ranking
A lot of modelling relies upon the weighting of factors.  You can spend a lot of time
arguing about the relative importance of factors and of values within factors.

Points to consider
1. Are the factors you are entering into the model of equal importance?
2. Is the range of values for each reclassified parameter based upon a linear scale, is

it weighted by some polynomial factor or some other mathematical function?
With Physical parameters, it is often possible to apply a physical rule.  It is less
easy to get a ready made rule for social or economic factor?

Exercise
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The following area selection of mini-projects you could run.  Select one closest to the
area of your work and work through it.

Sedimentation: Can you show the risk of erosion in the Kigoma area based upon the
slope and the land cover and population?

Biodiversity: Find places suitable for a natural reserve near Bujumbura based on
known biodiversity, and preservation from sedimentation and pollution.

Pollution - Look at the distribution of potential pollution sources (make a small
database showing where these are).

Planning – Can you make a map which defines rudimentary zones of development
for fisheries, biodiversity conservation and sedimentation traps.

Fishing - Map the concentration of boats around the lake.  How does this relate to the
literature biodiversity database?  Are fisheries close to areas where important
commercial fish are located?

Socio-economic - Make a map showing people’s proximity to Urban centres around
the lake and beyond.  Can you assign a value to each settlement that defines how good
access is for these people to non-lake livelihoods?

In each case, make a diagram that shows how you make the model, which datasets are
you using and what GIS processes do you need to run.
At the end, come up with three suggestions how you could improve the model - what
other data might be necessary?
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